Welcome to
Microsoft Office 2010
Welcome to Microsoft Office 2010

2.0 hour

In this workshop we will investigate the new Microsoft Office 2010 Fluent user interface. Topics include the Ribbon and Tabs, customizing the Quick Access Toolbar, shortcuts, and tips for more efficient use of the Office 2010 products.

Welcome to Microsoft Office 2010................................................................................. 1
Ribbon ................................................................................................................................. 1
   Moving Through the Ribbon.......................................................................................... 1
   Minimizing the Ribbon.................................................................................................. 2
   Working with Groups.................................................................................................... 2
   Contextual Tabs .......................................................................................................... 2
   Backstage (File Tab) .................................................................................................... 3
   Advanced Features ...................................................................................................... 3
   Customizing Tabs ........................................................................................................ 3
Quick Access Toolbar...................................................................................................... 4
   Customizing Quick Access Toolbar ........................................................................... 4
   Moving the Quick Access Toolbar ............................................................................. 4
Application Options ......................................................................................................... 4
Office Help ....................................................................................................................... 5
Formatting Text ................................................................................................................ 5
   Live Preview .................................................................................................................. 5
   Mini Toolbar ................................................................................................................. 5
Status Bar ......................................................................................................................... 5
Zooming ............................................................................................................................. 6
Protected View ................................................................................................................ 6
New Features for Microsoft Office Applications ............................................................ 7
   New Microsoft Word Features .................................................................................... 7
   New Microsoft PowerPoint Features .......................................................................... 7
   New Microsoft Excel Features .................................................................................... 8
   New File Extensions ..................................................................................................... 8
Using Microsoft Office 2010 at Home ............................................................................. 9
   Microsoft "Work At Home" Program for Employees ................................................... 9
   What are the terms and conditions of use? ................................................................. 9
   How to obtain software? .............................................................................................. 10
Welcome to Microsoft Office 2010
The most noticeable change in Microsoft Office 2010 from Microsoft Office 2003 is the introduction of the “Microsoft Office Fluent User Interface”. The familiar menus and toolbars are gone. Now we have a Ribbon of Tabs and a Quick Access Toolbar.

Ribbon
The Ribbon has a set of Tabs that contain organized Groups of tools. Each application has its own set of standard Tabs.

Excel

Outlook

PowerPoint

Word

The number of buttons shown will change depending on the width of your window. Wider screens will show more details. If the application window is not maximized, the Ribbon will be abbreviated.

Moving Through the Ribbon
Click on any Tab name to show its buttons. The scroll wheel on the mouse will move through the Tabs if the mouse is hovering in the Ribbon Pane.

The Alt button on the keyboard opens a list of shortcut letters to help you move through the Ribbon. Microsoft assigns numbers to the Quick Access Toolbar options.

If you choose the Tab "letter" (i.e. Alt-H), a new set of shortcut letters will appear for the options in just that ribbon.
Minimizing the Ribbon
The Ribbon takes up a fair amount of the application window. If you would like to "hide" the tools you can minimize the Ribbon. The Minimize the Ribbon button can be found in the upper right hand of the window, next to the Help button below the Exit button. The Ribbon automatically minimize if you double-click on any of the Tab names, or press Ctrl-F1.

To expand the Ribbon Pane again, choose the Expand the Ribbon button, or double-click on any Tab name, or press Ctrl-F1.

Working with Groups
There are often more options available than are shown in the groups.

The MORE button, officially the “Dialog Box Launcher”, opens a dialog box such as the Format Font and Format Paragraph windows, or a panes such as Styles and Clipboard.

Contextual Tabs
Each application has a set of standard Tabs (Home, Insert...). There are also Contextual Tabs that only appear when certain objects are selected.

Word Table
Excel Chart
PowerPoint Picture

These Contextual Tabs disappear when the object is no longer selected.
**Backstage (File Tab)**
The **File Tab** represents the **Backstage** of your file. This area is where you find everything you would do “to” a file that you would not do “in” a file, features like Open, Save, and Print. To close the **Backstage** area press the ESC key, or click on another tab.

**Advanced Features**
Features such as building forms and creating macros can be found on the **Developer Tab**. By default this tab is not shown. To turn it on, go to the Options, Customize Ribbon, and click the check next to the **Developer Tab**.

**Customizing Tabs**
In Office 2010 we can add and remove groups to the standard **Tabs**, and make **Custom Tabs**. You cannot modify the existing **Groups**, but you can add and remove buttons from **Custom Groups**. To modify your ribbon open the application Options. **File Tab, Options, Customize Ribbon**, or right-click inside the ribbon and choose **Customize the Ribbon**...
Quick Access Toolbar
The upper left hand corner of the application window has a Quick Access Toolbar. This is a convenient location to place commonly used buttons, no matter which Tab in the Ribbon you are viewing these buttons will always be displayed. By default this toolbar has Save, Undo, and Redo/Repeat buttons.

Customizing Quick Access Toolbar
There is a drop down button (▼) at the end of the Quick Access Toolbar that will help you to change the displayed buttons. This drop down list displays several common choices, including New Document and Quick Print. When you choose the option it will place the button on the Quick Access Toolbar.

Any button available on the Ribbon can be placed on the Quick Access Toolbar by right-clicking on the option and choosing Add to Quick Access Toolbar. A button can be removed from the Quick Access Toolbar by right-click on the button in the Quick Access Toolbar and choose Remove from Quick Access Toolbar.

From the drop down or right-click menus there is an option to Customize Quick Access Toolbar... This option will open the Options Window. From here you can add and remove multiple buttons at once, arrange the order of your custom toolbar and include <separators> which are dividing lines between your chosen commands.

Moving the Quick Access Toolbar
The Quick Access Toolbar has two location possibilities. The default is in the title bar at the top of the window, but it can also be moved below the Ribbon. Open the Customize Quick Access Toolbar button (▼), and choose Show Below the Ribbon. This will allow more room for your selected tools.

Application Options
The options for each application are no longer scattered throughout the menus, all options can be found under the File Tab, above the Exit button.

From here you can set general properties such as the Live Preview; proofing options such as Spelling, Grammar and AutoCorrect; save options such as the default file format; you can customize the Ribbon and Quick Access Toolbar; install Add-Ins; and change your security settings in the Trust Center.
**Office Help**
The Tooltips (shown when the mouse hovers over the button) have become more elaborate, sometimes showing a full paragraph and images to assist the user.

The Help button ( guru ) can always be found in the upper right hand corner of the application window (under the exit button).

The Help content also includes searching and viewing Office Online articles. This does mean you will need an internet connection to access many of the help files.

The function key, F1, will still launch Help, or you can open Help from the File Tab.

**Formatting Text**
The new default font Microsoft Office 2010 is Calibri. In Word there is also a new default spacing of 1.15 lines with 10 pts after each paragraph.

**Live Preview**
Office 2010 has a feature called Live Preview. When an object or text is selected, and you hover over some of the formatting options, Office will change the selection to match, giving you a “preview” of the new format. You will see this while formatting fonts, styles, and drawing objects. The Live Preview can be turned off from the application’s options.

**Mini Toolbar**
When text is selected a semi-transparent Context Toolbar appears to the upper right of the selection. When the mouse is moved over this Mini Toolbar it will become solid and you can choose some of the most-used formatting commands. This Mini Toolbar also appears on the right-click menu. The Mini Toolbar is not customizable and can be turned off from the application’s options.

**Status Bar**
The Status Bar in the bottom left corner of the application window is customizable. Right-click on the status bar and choose the options you would like to display/hide. The list will be different for each application.
**Zooming**
The bottom right hand side of the window in Word, Excel and PowerPoint shows a **Zoom Slider**.

- The plus will zoom in and make the file appear larger; the minus will zoom out and make the file appear smaller.
- You can use the scroll box, shown above in the middle of the zoom bar, to manually make adjustments.
- If you click on the percentage shown, it will open the Zoom window.

**Protected View**
Files opened from a non-trusted location will open in a “Protected View”. Files from a potentially unsafe location, such as emails or websites, may contain harmful content such as macros or ActiveX controls.

You will have to click the **Enable Editing** button to be able to make changes to the file. If you want to mark a folder as a safe location, you can change the **Trust Center Settings** in the options of the applications.

![Protected View](image)
New Features for Microsoft Office Applications

- SmartArt graphics can be used to make your images appear more professional.
- Pictures can be modified by changing color intensity and tone. They can also be adjusted by brightness, contrast, sharpness, blurriness, and recoloring.
- Ribbon tabs can be customized, and new custom tabs can be created.
- Built in Equation tool on Insert Tab can be used to add mathematical equations.
- Save files as PDFs under the Save and Send to on the File Tab.

New Microsoft Word Features

- Artistic effects for pictures and text, including text formatting features with ligature settings.
- Navigation and search pane can be used to quickly move through or reorganize your documents.
- Shared documents can be edited by multiple users at the same time.
- Preset gallery of cover pages with fields for Author, Title, Date, Abstract, etc.
- Automated generation of citations and bibliographies according to defined style rules, including APA, Chicago, and MLA. Changing style updates all references automatically.

New Microsoft PowerPoint Features

- Improvements to text rendering to support text based graphics.
- Rendering of 3D graphics.
- Support for many more sound file formats such as .mp3 and .wma.
- Support for tables and enhanced support for table pasting from Excel.
- Any custom-designed slide library can be saved.
- Added support for widescreen slides.
- Merge and Compare feature can be used to combine presentations.
- Link to a video from a website such as YouTube or Hulu.
**New Microsoft Excel Features**

- Formula Autocomplete, automatically suggests function names, arguments and named ranges, and automatically completing them if desired, based on the characters entered.
- Support up to 1,048,576 rows and 16,384 columns in a single worksheet, with 32,767 characters in a single cell (Office 2003 and earlier had 65,536 rows and 256 columns)
- Improved Sort and Filter functions including the ability to sort and filter by color.
- New Page Layout View, where you can see header/footers with the data.
- New charting engine, which includes 3-D rendering, transparencies and shadows. Number of data points for a chart is now limited only by available memory.
- Improved Conditional Formatting including inserting Icon Sets and Data Bars.
- PivotTables can now support hierarchical data by displaying a row in the table with a "+" icon, which, when clicked, shows more rows in that group.
- Sparklines (tiny charts that fit in cells) can visually show patterns or trends in your data.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Items</td>
<td>1st Qtr</td>
<td>2nd Qtr</td>
<td>3rd Qtr</td>
<td>4th Qtr</td>
<td>Trend</td>
</tr>
<tr>
<td>2</td>
<td>Pants</td>
<td>456</td>
<td>489</td>
<td>423</td>
<td>468</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Shoes</td>
<td>498</td>
<td>435</td>
<td>472</td>
<td>436</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Socks</td>
<td>128</td>
<td>168</td>
<td>157</td>
<td>138</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Blouses</td>
<td>579</td>
<td>498</td>
<td>531</td>
<td>589</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Hals</td>
<td>126</td>
<td>129</td>
<td>123</td>
<td>119</td>
<td></td>
</tr>
</tbody>
</table>

*Sparklines*

**New File Extensions**

Office 2010 files will be saved with new extensions. Microsoft has changed how files are saved using XML. These new file formats can be up to 75% smaller than earlier versions.

**Office File Extensions**

<table>
<thead>
<tr>
<th></th>
<th>Word Documents</th>
<th>Excel Spreadsheets</th>
<th>PowerPoint Presentations</th>
<th>Access Databases</th>
</tr>
</thead>
<tbody>
<tr>
<td>Office 97-2003</td>
<td><em>doc</em></td>
<td><em>xls</em></td>
<td><em>.ppt</em></td>
<td><em>.mdb</em></td>
</tr>
<tr>
<td>Office 2010</td>
<td><em>.docx</em></td>
<td><em>.xlsx</em></td>
<td><em>.pptx</em></td>
<td><em>.accdb</em></td>
</tr>
</tbody>
</table>

If you are working in Office 2010 and would like to send a file to someone still using Office 2003, save the file as a previous version, File Tab → Save As → Word 97-2003 Document. The file will then appear in “compatibility” mode and some of the new features will not be available.

If you open a 2003 or earlier version of a file, you will open the file in [Compatibility Mode], and some of the newer options will be unavailable. If you save the file to the new version, remember the file size will probably shrink and people using earlier versions of Microsoft Office may not be able to open the file.

Updated 7/27/11
Using Microsoft Office 2010 at Home
Microsoft Office provides a trial version that can be used for typically 60 days. You can find more information on their website: http://us20.trymicrosoftoffice.com/default.aspx.

University of Florida Employees can obtain a copy of Microsoft Office from the University Bookstore. (http://www.software.ufl.edu/ms)

Microsoft "Work At Home" Program for Employees
The Microsoft Campus Agreement with certain restrictions allows Shands and UF employees to use the following Microsoft products at home:

- Microsoft Windows 7 Ultimate. This is an "Upgrade".
- Microsoft Office: Microsoft Office Professional Plus 2010 for Windows or Microsoft Office Standard 2011 for Macintosh. (Only one Office product can be obtained.)

Students are also covered under the Microsoft Campus Agreement. For information concerning the student option, visit the Microsoft Program for Students page (http://software.ufl.edu/ms/msstudent.html).

What are the terms and conditions of use?
The University of Florida has purchased license coverage for Microsoft Office and Windows 7 Ultimate upgrade through its Microsoft Campus Agreement for all Shands and UF employees. The employee is required to buy the installation media.

To participate in this agreement, you must acknowledge and agree to the terms and conditions listed:

- You do not own the license or the DVDs, rather you are authorized to use the software and associated media pursuant to the terms and conditions of the Microsoft Campus Agreement (http://www.software.ufl.edu/microsoft/).
- You will be required to remove the software from your personal computer when your employment by Shands or the University of Florida ends.
- You will be required to remove the software from your personal computer should the Shands/University of Florida end its agreement with Microsoft. Should this license agreement expire, an announcement will be issued to the UF community and from this web site.
- You must be a University of Florida or Shands employee. (An employee is any person who receives a paycheck from the University of Florida or Shands.)
- You must read and abide by the license agreement(s) associated with this software when you install the software.
- No technical support is provided by Microsoft. The UF Computing Help Desk (392-4357) can be contacted for assistance in the installation of the software provided in this program.

Updated 7/27/2011
• The minimum specifications to run the Software are listed at Microsoft's Office 2010 system requirements web page and Windows 7 System Requirements web page.

• You are entitled to only one copy of the software for work at home use.

• You will remove the software from your home machine immediately upon the earlier of (a) expiration of the license agreement or (b) the end of my employment by the University of Florida or Shands.

*How to obtain software?*
In order to obtain MS Office and the Upgrade of the MS Windows 7 Ultimate software follow these instructions:

Step 1: Print, read and sign Microsoft Campus Agreement, "Microsoft Campus Agreement: Work at Home Acceptance Form" acknowledging that you understand the Terms and Conditions of use of the Microsoft software.

Step 2: Check your Gator1 ID.

• If the designation on your Gator1 ID card is "Faculty" or "Staff", your Gator1 card is all that is required to show proof of employment.

• If you do not have a Gator1 card, you are required to obtain a UF ID before purchase. If you do not have a Gator1 card but have a UF ID then you can obtain a copy of your UF Pay stub by using the PeopleSoft system. Once signed on to the PeopleSoft system, navigate to My Self Service and Payroll and Compensation. Select the View Paycheck option. Use the Printer friendly version link option to view and print an acceptable pay stub.

Step 3: Take the Microsoft Campus Agreement: Work at Home Acceptance Form, your UF Gator1 ID (or pay stub) to the one of these three locations:

• Technology Store located in the University Bookstore in University of Florida Bookstore and Welcome Center

• The Bookstore with Shands

• The UF Computing Help Desk at the HUB

*The sales clerk will require these at the time of purchase.*